Table of Contents

General Guidelines ................................................................................................................. 4
  Types of Requests Permitted .......................................................................................... 4
  Timing of Request Submissions ..................................................................................... 4
  Holiday Closings ............................................................................................................... 4
  Image/File Upload Guidelines ......................................................................................... 5

Starting a Request .................................................................................................................. 6
  Type of Request ............................................................................................................... 6
  Requestor Information ..................................................................................................... 6

Broadcast Email and eNewsletter Requests ......................................................................... 7
  Summary ........................................................................................................................... 7

  Request Form: Email/eNewsletter Part 1: Recipients and Headers ................................ 7
  Field Item 1: Example Recipient Groups ......................................................................... 7
  Field Item 3: Default “Reply-To” Email Address ............................................................... 8
  Field Items 2, 4, 5: Example Email Headers (“Subject”, “From” name, “Reply-To” email address) ................................................................. 8

  Request Form: Email/eNewsletter Part 2: Message Content Files ................................. 9
  Maximum Total File Size for all Uploaded Files and Form Field Content: 1MB ............. 9
  Optional Personalization of Email Message Content ....................................................... 10

  Request Form: Email/eNewsletter Part 3: Delivery and Special Instructions ................. 14

Event Calendar/Online Event Registration Requests ............................................................ 15
  Summary ........................................................................................................................... 15

  Field Item 1: Example Event Sponsors/Hosts .................................................................. 16

  Request Form: Event Part 2: Event Description Files ...................................................... 17
  Maximum Total File Size for all Uploaded Files and Form Field Content: 1MB ............. 17
  Example Event Content File 1: Online Registration ....................................................... 18
  Example Event Content File 2: Event Announcement .................................................... 19

  Request Form: Event (Registration) Part 3: Attendee Details ....................................... 19

  Request Form: Event (Registration) Part 4: Pricing/Payment Details ............................ 19
  Example Cost Per Person Information ............................................................................. 20
  Examples of Other Information to Include ..................................................................... 20

Reviewing, Editing, Finishing (or Cancelling) Request ......................................................... 21

Last Updated 4/30/15
Frequently Asked Questions ................................................................. 21
  I seem to be stuck on the same form page, cannot go forward, what’s happening? ............ 21
  An error message says a file with that name has already been uploaded........................... 21
  An error message says my files are too big to upload, how do I resize them? .................... 21

Appendix A: How to Compress An Image with Mac Preview Application .................. A-1
Appendix B: How to Compress An Image with Microsoft Office Picture Manager .... B-1
General Guidelines

Types of Requests Permitted
The broadcast email, eNewsletter, and event calendaring services are provided solely for the advancement of Vassar College and are not intended to promote or advertise personal or external (non-Vassar) fundraising or events. Vassar’s Office of Alumnae/i Affairs and Development (OAAD) reserves the right to review, edit, or decline sending any broadcast email/eNewsletter or posting any event on its calendar. However, the online community allows alumnae/i venues such as class notes and classifieds to promote or announce their activities and businesses. For more information on the online community and its tools, please visit the Connect section of our website at http://connect.vassar.edu.

eNewsletter requests may be submitted only by alumnae/i groups who have completed a custom template design and approval process with OAAD. Any class, club, affiliate group, or Vassar department may request the creation of an OAAD-approved custom template design. Please contact Susan Brkich, OAAD's Associate Director of Web Services, at subrkich@vassar.edu or 845.437.5449 for further information. Note: This process does not encompass delivery of a PDF-version of a printed newsletter -- such requests should be submitted as an ordinary email request with the PDF referenced in the content message as a download, and the PDF uploaded with the request as an additional file.

Timing of Request Submissions
Processing requests requires, at a minimum, three (3) full business days for broadcast email and event calendaring/registration requests and five (5) full business days for eNewsletter requests. An event calendaring request will be rejected if the event is taking place less than three days after the request is submitted. If an event request is submitted in conjunction with a broadcast email announcing the event and linking to the event, the event will be posted prior to delivery of the broadcast email.

A follow-up message to a broadcast email can be sent prior to an event as a reminder. No announcement will be sent less than seven (7) days prior to an event, unless it is a follow-up message reminder (with rare exceptions).

Requests submitted during office closures, holidays, weekends, or weekdays after 4 pm US Eastern Time will not begin processing until the next business day.

Give your constituents time to plan for events. Thirty (30) days is best - seven (7) days is the absolute minimum. Remember, no initial announcement of an event will be sent less than seven (7) days prior to the event.

Holiday Closings
Please note that OAAD is closed every year from on or about Christmas Eve Day through New Year's Day, and no requests received during this time period or within three (for broadcast emails or event calendar postings) or five business days (for eNewsletters) prior to this time period can be processed. Broadcast email or eNewsletter requests made sufficiently in advance of the winter holiday closing may be scheduled for actual delivery during the holiday closing period. See Vassar's complete yearly holiday schedule at http://humanresources.vassar.edu/holiday/index.html.
Image/File Upload Guidelines
You have the option to upload a certain number of images or documents (depending on your type of request) to be included in or linked within your broadcast email, eNewsletter, or event calendar posting. The images must be saved in .tif, .tiff, .jpg, .jpeg, or .gif format. The documents must be saved in Adobe PDF, plain text, Word, Excel, or Powerpoint/Keynote format. All files and form field content to be uploaded on a specific request page must be less than a combined total file size of 1MB (1000KB), or the files will not upload and the request cannot be completed.

Questions?
Contact OAAD at 845.437.5400 or 800.413.8196.
Starting a Request

Always begin your requests from the Broadcast Services webpage, at: http://alums.vassar.edu/volunteer/broadcast-services.html

Type of Request
Choose the type of request you are submitting by clicking one of the radio buttons (see image below). You can submit a broadcast email and event calendar announcement and online registration request all at once, or choose to do them separately.

Requestor Information
Fill in your name and all other required fields. Be sure to identify your position/role in the drop-down list at the bottom (see image below). Even if you are submitting this request on behalf of someone else, please fill in your information and your position here.
Broadcast Email and eNewsletter Requests

Summary
For Broadcast Email and eNewsletter requests, you must have the following information and files ready before you begin the online request form:

- Intended recipient group(s)
- What should appear on the “Subject” line in the email header
- Preferred delivery dates (initial and any follow-up)
- A Word (.doc), rich text (.rtf), or plain text (.txt) document containing the email message or eNewsletter content only (with any personalization merge fields indicated), NO images included (see below for file size limitations)
- Separate image files for any images (see below for file size limitations)
- No attachments allowed, only links to download/view additional files
- Separate Word, rich text, or PDF files for any files to be linked to in the email or eNewsletter (see below for file size limitations)

Request Form: Email/eNewsletter Part 1: Recipients and Headers

The image below shows what the first part of the form looks like. Use the numbers on the image to find examples and helpful tips below.

Field Item 1: Example Recipient Groups
Specify recipient groups by class year, club name, major(s), and/or regional areas, or any combination thereof:
Vassar Club of Chicago
Class of 1972
Vassar Alumnae/i in VT and NH
Vassar Grads of last 10 years in NY, NJ, CT
Current Parents and Students
Vassar History Majors

Do not use vague generalizations such as “east coast”, but define by club area names or counties. **But note** you can use the following two descriptions for recipient lists, which are defined as stated:

- **Metro NYC Alumnae/i** = Club areas (home, business, seasonal, secondary) of NYC, Long Island, Westchester, Poughkeepsie, North/Central NJ, and Fairfield CT
- **Tri-State Alumnae/i** = Entire states of NY, CT, NJ

*Note for Vassar Staff: If recipient group is to be from an upload list, note that list of PIDMs is attached to request and upload PIDM list (no emails, names, or other information).*

**Field Item 3: Default “Reply-To” Email Address**
The default “reply-to” email address in the online request form is preset to OAAD’s general email address. Unless you are a class correspondent submitting a request for class notes, this should not be changed.

If you change the "reply-to" email address to be your email address, when the broadcast email is delivered, you will receive all the "out of office" or other automated replies that the recipients may have set up on their email accounts. If your broadcast is going to a large group, your email in box may be flooded with these automated replies.

**Exception for Class Correspondents: You will generally always change the "reply-to" email address to your email address.**

The [oaadweb@vassar.edu](mailto:oaadweb@vassar.edu) email account is monitored regularly during business hours and over OAAD's winter holiday break period. Any replies to a broadcast email sent to this account will be redirected/forwarded to the appropriate person(s) for whom they are intended.

**Field Items 2, 4, 5: Example Email Headers (“Subject”, “From” name, “Reply-To” email address)**

**From:** Your Vassar Class Correspondent  
**Reply-To:** realEmail@yourISP.com  
**To:** “recip@ISP.net” <recip@ISP.net>  
**Subject:** Write to Class Notes!

**From:** Your Vassar Class  
**Reply-To:** oaadweb@vassar.edu  
**To:** “recipientEmail@herISP.net” <recipientEmail@herISP.net>  
**Subject:** 1973 Class Dues Reminder
From: Your Vassar Affiliate Group
Reply-To: oaadweb@vassar.edu
To: “recipientEmail@hisISP.com” <recipientEmail@hisISP.com>
Subject: APAVC Lei Ceremony on May 26

From: Your Local Vassar Club
Reply-To: oaadweb@vassar.edu
To: “recipientsEmail@herISP.net” <recipientsEmail@herISP.net>
Subject: Private Tour of the Blanton Museum of Art's A Century of Grace Exhibit

From: Vassar College
Reply-To: oaadweb@vassar.edu
To: “recipientEmail@herISP.net” <recipientEmail@herISP.net>
Subject: Powerhouse Theater Apprentice Training Program

From: The Frances Lehman Loeb Art Center
Reply-To: fllac@vassar.edu
To: “recipientEmail@herISP.net” <recipientEmail@herISP.net>
Subject: 'East Meets West'

From: Alumnae and Alumni of Vassar College
Reply-To: oaadweb@vassar.edu
To: “recipientEmail@hisISP.com” <recipientEmail@hisISP.com>
Subject: Southern California GOLD -- A Gathering of Young Alumnae/i

Request Form: Email/eNewsletter Part 2: Message Content Files

The image below shows what the middle part of the form looks like (it is longer for eNewsletters). Find useful tips on creating your content and uploading your files below.

Maximum Total File Size for all Uploaded Files and Form Field Content: 1MB
All files and form field content to be uploaded on a specific request page must be less than a combined total file size of 1MB (1000KB), or the files will not upload and the request cannot be
completed. If you are submitting a combined broadcast email/event calendaring request, the limit is 1MB for the broadcast email files/content plus 1MB for the event calendaring files/content (as each is on a separate request page).

**Optional Personalization of Email Message Content**

You may personalize your email message content for your recipients with various "tags", by including them in square brackets in the appropriate place(s) in your email message content document. Examples of the most popular personalization tags available are:

- First Name
- Last Name
- Preferred Class Year
- User Name *(to log into Vassar's Alumnae/i Online Community)*
- Vassar ID *(required for alumna/us to register with Online Community)*

See the following pages for examples of personalized email messages.
Dear [first-name],

Our very first Vassar College reunion is just 2 months away, and we want to make sure you'll be there! We hope you have marked your calendars for June 9-11, 2006. This just in…the class of 2001 will be housed in the TH's (the other classes knew we were a rowdy bunch). **Register online today** [Instruction: make the words "register online today" a link to https://www.aavc.vassar.edu/fakelink/fakeregisterpage.php] using your **ID number**: [Vassar ID].

Reunion weekend 2006 will offer plenty of opportunities designed to help us renew old friendships, explore changes to the Vassar campus, relax and just have a good time.

The Reunion Committee is working hard to ensure you'll have a memorable time. Some of the activities planned include:

- Fireworks over Sunset Lake
- Bonfire (to make up for the one we never had during Senior Week)
- Alumnae/i Parade
- Cocktail reception and class dinner in the TH Circle

**April 4-May 8 are the dates you can register online** [instructions: make the words "register online" a link to https://www.aavc.vassar.edu/fakelink/fakeregisterpage.php]. We want to remind you to get those registrations in by May 8th to guarantee your space at reunion and to be housed in the TH’s with your classmates.

The Mug is calling your name…please join us in celebrating THE VASSAR ODYSSEY, CLASS OF 2001! **Register online today** [instructions: make the words "register online today" a link to https://www.aavc.vassar.edu/fakelink/fakeregisterpage.php] using your **ID number**: [Vassar ID].

Take care,
2006 Reunion Committee
ENCORE!

A SPECIAL EVENT FOR CHICAGO AREA VASSAR ALUMNAE, 1960-1969

(Picture here if possible)

when: Saturday, March 24
9:30 AM coffee
10:00 Panel discussion followed by small
group discussion and light refreshments

why: to reconnect, provoke thought and laughter,
figure out what’s next for us

where: The Heritage
130 N. Garland Ct., Chicago, 60602
(One half block west of the Chicago Cultural Center,
Between Washington and Randolph)

r.s.v.p. this link (please fill in link to calendar posting)
or Ann Brody at 312-346-2265

To RSVP to the event, we encourage you to click on this link to the AAVC(please make the calendar link) website where you can find out who is coming to the event and explore the other resources available to you at the website. You do not need to register in the Alumnae’s Directory to RSVP, but registering will enable us to stay connected and communicate more easily with each other. To find your ID number, which is needed to register, look on the mailing label of your Vassar Quarterly.

Please join Vassar alumnae from the 1960s at a special event on Saturday, March 24. Although sponsored by the Chicago Vassar Club, this occasion is not intended as a fundraiser — in fact, there is no charge to attend. Fourteen years ago, we held a similar gathering for our decade, a morning devoted to exploring the topic of how well Vassar prepared us for the lives we turned out leading. It produced a remarkably frank exchange of ideas, with a panel that reflected the broad range of societal changes that took place during the ’60s. A number of us have stayed in touch and become resources for each other in valuable and unexpected ways. We thought it was time to reconvene and inspire each other again as we face new transitions in our lives. We may be aging, but there is still time to take another bow, or two. So come join us as we reprise the discussion, figure out the encores we want to make, and find others of similar mind.
Dear (first name),

Reunion 2007 registration is still open! You can still register for meals, registration fees, and possibly housing. Register for our upcoming 20th Reunion online at www.aavc.vassar.edu/reunion/register.html. To register you will need your ID number, which is (ID Number). Also, there still may be on-campus housing available, please call AAVC at 845.437.5445 to find out.

Click here for reunion kids camp information and click here for reunion wine tasting information. If you have any questions call Lisa Denby at 917.796.0180 or email denby@alum.vassar.edu.

We hope you can join us!

— Your Reunion Team

(Make the words “Click here for reunion kids camp” a link to the uploaded pdf containing kids camp information, and “click here for reunion wine tasting” a link to the uploaded pdf containing wine tasting information.)
Request Form: Email/eNewsletter Part 3: Delivery and Special Instructions

The image below shows what the bottom part of the form looks like (note that follow-up options only appear for regular emails, not for eNewsletters). Use the special instructions box for things such as requesting a test email be sent to you (if you are not Vassar OAAD staff), asking for expedited processing for a specific reason, etc.

Standard processing time is 3 full business days for emails, 5 full business days for eNewsletters. Requested delivery dates/times may need to be adjusted by OAAD staff, depending on the number of other requests or other priorities. If you have a specific delivery time, please note it in the special instructions. Emails can be scheduled to go out any hour, on the hour (7am, 8am, 9am... 1pm, 2pm, etc.)

If the follow-up message requires different language, or is to go to a more targeted group than the first email, please submit a separate request.

![Broadcast Email Part 3: Delivery Options and Special Instructions](image-url)
Event Calendar/Online Event Registration Requests

Summary
For Event Calendar/Registration requests, you must have the following information and files ready before you begin the online request form:

- Group hosting/sponsoring the event
- Event title (and optional short descriptive tagline for calendar listing)
- Start date and time, end date and time (option for no time is available for all-day events)
- Location, if known
- A Word (.doc), rich text (.rtf), or plain text (.txt) document containing the description of the event, NO images (NOTE: this file cannot be the same file used for a broadcast email request made at the same time)
- Separate image file if there is an image to include with the description*
- Separate Word, rich text, or PDF files for any files to be linked to in the event description*
- If applicable, registration information:
  - Cost per person, including any discounted price, for event or specific items
  - Menu options for meals, size options for clothing items, etc.
  - Maximum number of tickets, if any, for the event and/or per person
  - Should credit be given for cancellations, and if so, up until what date?

*If your event image file and/or additional linked files are the same as submitted in a concurrent broadcast email request, you do not need to upload them again, just specify in the special instructions box that the files were already uploaded as part of the concurrent broadcast request.


The image on the next page shows what the first part of the form looks like. Use the numbers on the image to find examples and helpful tips below the image.
Field Item 1: Example Event Sponsors/Hosts

Vassar Club of Chicago
Class of 1972
Vassar Education Department
OAAD and Vassar History Department
Vassar Regional Programs

Field Item 2: Event Title
Choose something succinct for a monthly calendar view, include sponsor where appropriate:

Class of 1962 Mini-Reunion
VCNY Orations and Libations
Austin Happy Hour
Lecture on the Teenage Brain by Professor Abigail Baird

Field Item 3: Optional Event Tagline
If included, this tagline appears in the List View of the alumnae/i online calendar. If event is not to be displayed on public calendar, this field will be ignored.
Field Item 4: Post on Public Calendar
The alumnae/i calendar has its home in the Connect section of the alumnae/i website, at the following URL: [alums.vassar.edu/calendar](http://alums.vassar.edu/calendar). Upcoming events are listed on the alums.vassar.edu homepage, as well. If your event is private, select “no” and your event will not appear on any of these public calendars. People will only be able to register or see the event via links provided in an email or print materials.

Field Item 5: Dates of Event
Events can be multi-day events, with or without start/end times. If an all-day event, select “none” as both the start/end times. If there is no specified end time for an event, enter the start time again.

Request Form: Event Part 2: Event Description Files
The image below shows what the second part of the form looks like. Find useful tips on creating your content and uploading your files below.

<table>
<thead>
<tr>
<th>Event Calendar/Registration Part 2: Upload Files and Special Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Event Description File:</strong></td>
</tr>
<tr>
<td><img src="image" alt="Browse..." /></td>
</tr>
<tr>
<td><strong>Optional Additional Files</strong></td>
</tr>
<tr>
<td>You may upload up to two additional files: any combination of images to include in the event page and/or documents to be linked within the event page.</td>
</tr>
<tr>
<td><img src="image" alt="Upload Limitations" /></td>
</tr>
<tr>
<td><strong>Additional file:</strong></td>
</tr>
<tr>
<td><img src="image" alt="Browse..." /></td>
</tr>
<tr>
<td><strong>Additional file:</strong></td>
</tr>
<tr>
<td><img src="image" alt="Browse..." /></td>
</tr>
<tr>
<td><strong>Special Instructions</strong></td>
</tr>
<tr>
<td>Enter any special instructions regarding this event, including email notifications for registrations, below:</td>
</tr>
<tr>
<td>![image]</td>
</tr>
</tbody>
</table>

Maximum Total File Size for all Uploaded Files and Form Field Content: 1MB
All files and form field content to be uploaded on a specific request page must be less than a combined total file size of 1MB (1000KB), or the files will not upload and the request cannot be completed. If you are submitting a combined broadcast email/event calendaring request, the limit is 1MB for the broadcast email files/content plus 1MB for the event calendaring files/content (as each is on a separate request page).
Example Event Content File 1: Online Registration

This example is from the Class of 1966, about a mini-reunion. Note that the file does not contain the event title or location, as that information is filled out in other fields of the submission form. It includes the date, but that can be omitted, as it can be included with the location information.

Get YOUR Kicks on Route 66!
Mini-Reunion in Santa Monica and Los Angeles
October 9 - 12, 2014

Our next and final stop on Route 66 is Los Angeles! The team has been hard at work planning another exciting mini reunion and we want you to be a part of it.

Highlights include:

Thursday, October 9

- Lunch and a private docent tour of the Autry National Center [make the words "Autry National Center a link to: http://theautry.org/] for the exhibition “Route 66: The Road and the Romance”
- Dinner at the Border Grill (the home of renowned chefs Mary Sue Milliken and Susan Feniger)

Friday, October 10

- Opening meeting at the home of Brenda Feigen, with introductions, your 3 minute life summaries- a fascinating glimpse of our lives since Vassar.
- A visit to the Getty Center with a docent-led tour followed by cocktails and dinner

What YOU need to do:

1. Let us know if you plan to attend by clicking the register button above or by emailing Barbara Weinstein Le Winter or Barbara Cort Counter
2. Reserve your rooms now at:

   - [Georgian Hotel](#) in Santa Monica
     Call (800) 538-8147 and ask for the Vassar group rate.
   - [Ocean View Hotel](#) in Santa Monica
     Call (800) 452-4888.

- This mini is over a holiday weekend so you will want to book fast.
Example Event Content File 2: Online Announcement

Come join us for

HAPPY HOUR!

Who needs a reason to eat in Decatur?

Parking around Decatur – [check out this handy map](link to PDF uploaded with request)

(Note: we recommend the garage on Church street)

Questions? Send them to ATLVCALUM@gmail.com

Request Form: Event (Registration) Part 3: Attendee Details

If your request includes online event registration, you will have this third section on the request form. The image below shows what it looks like. **If your event will be in a venue with a limited capacity, or if you only have a limited number of tickets to the event, specify the maximum number of attendees here.**

<table>
<thead>
<tr>
<th>Event Calendar/Registration Part 3: Event Attendee Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>*Display List of Attendees?  [select one]</td>
</tr>
<tr>
<td>(Registrants can choose not to display their names.)</td>
</tr>
<tr>
<td>Maximum Number of Attendees: [ ]</td>
</tr>
<tr>
<td>(leave blank if unlimited)</td>
</tr>
</tbody>
</table>

Request Form: Event (Registration) Part 4: Pricing/Payment Details

If your request includes online event registration, you will have this fourth section on the request form. The image on the next page shows what it looks like. Tips for filling out the cost and other information items (if your event is not free) appear below the image.
Example Cost Per Person Information
When filling in the cost information box on the form, be as specific as possible about prices for different items, any limits on the number of “tickets” available for each item, any early-bird registration or non-member discounts:

- Registration is $35.00, Dinner is $50.00, Commemorative Hat $10.00
- Price of event is $115.00, which includes dinner on Friday, breakfast on Saturday
- Tickets $35.00 each, limit 2 per person

Examples of Other Information to Include
If there’s a date by which registration should be closed, or meal choices, t-shirt or other merchandise selections, list them in the Other Information box:

- Option to select T-shirt sizes (S, M, L, XL)
- Meal choices are Salmon, Steak or Vegetarian
- Close registration on April 3rd, at 5pm
Reviewing, Editing, Finishing (or Cancelling) Request

Regardless of the type of request being submitted, you will have the opportunity to review every item you entered on the forms and the names of the files you uploaded, on the Review Request page. If you see a mistake, click the “Edit Request” button at the bottom of the page, make your changes and submit them, then review again.

Need to cancel your request? Do it on any page of the form up to and including the Review Request page. The button is at the bottom of each form page. Don’t just close the browser window, please use the Cancel Request buttons, as this clears out anything submitted up to that point, so that you can start fresh another time.

To complete your request and submit it for processing and setup/delivery, you must click the “Submit Request” button on the bottom of the Review Request page. You will receive an on-screen confirmation page listing all the details of your request, and you will get an email confirming the submission of your request. The confirmation email will give you a link and the ID numbers for your request, so that you can review the status of your request and its details at any time.

Frequently Asked Questions

I seem to be stuck on the same form page, cannot go forward, what’s happening?

Most likely the system timed out, if you spent more than 20 minutes on any given form page. If you can, cancel the request and start over. You may need to rename your files to be uploaded if you are unable to properly cancel your request.

An error message says a file with that name has already been uploaded.

This happens when a prior request is neither completed nor properly cancelled. You’ll have to rename your file in order to upload it. Remember, file names should not have apostrophes, forward or backward slashes, or other non alphanumeric characters in them.

An error message says my files are too big to upload, how do I resize them?

To compress (reduce the file size of) PDF files, use Acrobat Professional or any other software program you have that allows for creation and manipulation of PDF documents. If you do not have any of these programs, use Neevia’s online PDFcompress tool: http://docupub.com/pdftcompress/

To compress image files, use iPhoto, Photoshop (or Photoshop Essentials), or other image-editing program on your computer. Mac users can also use Preview, preinstalled on every Mac (see Appendix A for step-by-step instructions). Windows users with Microsoft Office Tool installed can also use Microsoft Office Picture Manager (see Appendix B for step-by-step instructions).
Appendix A: How to Compress An Image with Mac Preview Application

1. Open your image in Preview (in your Applications folder).
2. Go to Tools and select “Adjust Size...” (see image below).
3. In the window that appears, make sure that the dropdown next to the image width and height says “pixels” and notice the numbers displaying in the width/height fields (see image below).
4. Go to the “Fit into:” dropdown menu and choose an image size that is LESS than the current width and height of the image (see image below). 800x600 or 1024x768 are good options.
5. Note what happens in the boxed area at the bottom under “Resulting Size” – the size of the image will change, as pictured in the image below, where it is 150 KB. If the file size is still too large, pick a smaller “Fit into” number, or vice versa. You want all the images you are uploading to have a total combined file size no larger than about 800 KB, to allow additional room for your content file and other form field data.
6. Once you are satisfied with your resulting file size, click the OK button in the lower right of the window to resize your image. Don’t panic if it appears abnormally small, as in the image below. The display may be zoomed out. Go to the “View” menu and select “Actual Size” to see the actual screen display size of the image.

7. Under the File menu, choose “Save As…” and save your file with a different file name so that you don’t overwrite your original image file.
Appendix B: How to Compress An Image with Microsoft Office Picture Manager

1. Open your image in Microsoft Office Picture Manager (in Programs -> Microsoft Office -> Microsoft Tools folder).
2. Go to Picture and select “Compress Picture...” (see image below).
3. The window will change to display the Compress Pictures options on the right side. Choose the radio button next to “Web pages” and note the description that appears, explaining that the image dimensions will be reduced to 448 x 336 pixels as part of the compression (see image below).

The bottom part of the panel shows the compressed file size, as compared to the original file size.
4. Click the OK button to compress the image and note that the file name in the lower left corner is now preceded by an asterisk, to indicate that the file has been changed.

5. Under the File menu, choose “Save As…” and save your file with a different file name so that you don’t overwrite your original image file.